Apple Pro Training Series: GarageBand

The Apple-Certified Way to Learn

The only Apple-certified guide to GarageBand, Apple Pro Training Series: GarageBand will help you create, edit, and share original works in no time. Using real-life material and practical lessons that you can incorporate immediately into your own projects, this book and downloadable media offer a complete, self-paced course in all aspects of GarageBand. You’ll work with a wide range of media, including projects from a professional guitarist, an award-winning poet, an independent hip-hop recording artist, and award-winning dancers. You’ll master GarageBand tools quickly through fun projects, and share them using social media and iCloud. The book comes with an online bonus lesson on GarageBand for iOS that shows how to share projects via iCloud between iOS devices or create projects on your iOS device and finish them on your Mac.

Focused lessons take you step by step through:

- Mastering GarageBand for Mac with fun, real-world projects
- Arranging, editing, and mixing an original piece of music
- Creating a ringtone from scratch using Apple Loops
- Testing amp simulators and stomp boxes with an electric guitar solo
- Editing spoken dialog for an audio book
- Laying down original hip-hop beats using drum machine loops you create and dynamic tempo changes
- Adding EQ effects to a dance video to enhance the sound
- Sharing GarageBand songs via iCloud between iOS devices and your Mac (online bonus lesson)

The Apple Pro Training Series is the official self-paced learning guide of the Apple Training program. To learn more, please visit training.apple.com.

Also in the Apple Pro Training Series:
- iPhoto
- iMovie
- Aperture 3, Second Edition
- Final Cut Pro X 10.1: Professional Post-Production
- Logic Pro X: Professional Music Production

About the Author: Mary Plummer has been editing film and video professionally for over 20 years. An Apple Certified Trainer in Final Cut Pro, Motion, and Soundtrack Pro, she has edited music videos, documentaries, trailers, and independent feature films, and composed original music that has been used in film and video projects from coast to coast. She is co-owner of InVision Digital and Media Arts, located in Orlando, Florida. She was lead trainer for Apple’s Pro Certification program for more than ten years and traveled the country and Europe training new Apple certified trainers. She has authored numerous books, including Apple Pro Training Series: Soundtrack Pro; Apple Pro Training Series: Getting Started with Motion; and Apple Pro Training Series: Getting Started with Final Cut Studio.

Compartment Web Page: www.peachpit.com/aptsgb

Lesson files available for download

USA $29.99  Canada $33.99

Level: Beginner/Intermediate
Category: Digital Audio/Music
Requires: GarageBand for Mac 10.0.2 or later, Mac OS X 10.8.2 or later

Mary Plummer
This page intentionally left blank
## Contents at a Glance

Getting Started ......................................................... xi

| Lesson 1 | Working with a GarageBand Project | 1 |
| Lesson 2 | Working with Tracks | 37 |
| Lesson 3 | Working with Apple Loops and Arranging a Song | 73 |
| Lesson 4 | Recording and Editing Software Instruments | 111 |
| Lesson 5 | Recording and Editing Audio Tracks | 153 |
| Lesson 6 | Working with Electric Guitars | 189 |
| Lesson 7 | Creating Drum and Percussion Tracks | 239 |
| Lesson 8 | Mixing Music and Adding EQ Effects | 273 |
| Lesson 9 | Sharing Your Finished Projects | 295 |

Bonus Lesson 1:
Learning to Play Piano
and Guitar with GarageBand ....................... Online

Bonus Lesson 2:
Working with GarageBand for iOS ....................... Online

Index ................................................................. 308

*See last page of this eBook for instructions on downloading your lesson files.*
## Table of Contents

Getting Started .................................................. xi

**Lesson 1**

Working with a GarageBand Project ............... 1
  Downloading GarageBand Projects for This Book .... 2
  Opening and Saving a GarageBand Project .......... 3
  Exploring the GarageBand Window .................... 5
  Navigating and Controlling Playback ................. 8
  Exploring the Workspace, Tracks, and Regions ....... 11
  Exploring the Library ....................................... 14
  Using a Cycle Area ......................................... 17
  Exploring the Smart Controls Pane .................... 18
  Exploring the Editors ..................................... 21
  Showing the Project Note Pad .......................... 24
  Project Tasks ............................................... 25
  Working with Apple Loops ............................... 26
  Auditioning and Adding Loops to the Project ....... 29
  Adjusting a Track’s Volume .............................. 31
  Changing a Track’s Name and Icon .................... 32
  Lesson Review ................................................. 34

**Lesson 2**

Working with Tracks ................................. 37
  Understanding Tracks ................................... 38
  Previewing the Finished Project ....................... 38
  Opening a Project from GarageBand ................... 40
  Exploring the Starting Project ....................... 40
  Working with Solo and Mute Controls ................. 42
Lesson 3
Working with Apple Loops and Arranging a Song
Opening a New Project Template
Exploring the Ringtone Template
Understanding Loop Preferences
Searching for Loops
Deleting a Track
Working with Keyword Buttons
Customizing the Keyword Buttons
Searching with Multiple Keyword Buttons
Understanding Melody and Rhythm
Building Rhythm Tracks in the Timeline
Project Tasks
Selecting Favorite Loops
Project Tasks
Bonus Exercise
Lesson Review
<table>
<thead>
<tr>
<th>Lesson 4</th>
<th>Recording and Editing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software Instruments</td>
<td>111</td>
</tr>
<tr>
<td>Preparing the Project</td>
<td>112</td>
</tr>
<tr>
<td>Using Catch Mode to Keep the Playhead Visible</td>
<td>112</td>
</tr>
<tr>
<td>Single-Take Recording</td>
<td>114</td>
</tr>
<tr>
<td>Playing Music with Your Computer Keyboard</td>
<td>116</td>
</tr>
<tr>
<td>Recording a Single Take in the Timeline</td>
<td>118</td>
</tr>
<tr>
<td>Fixing Notes in the Piano Roll Editor</td>
<td>121</td>
</tr>
<tr>
<td>Project Tasks</td>
<td>126</td>
</tr>
<tr>
<td>Working with Smart Controls and the Arpeggiator</td>
<td>127</td>
</tr>
<tr>
<td>Preparing the Project</td>
<td>129</td>
</tr>
<tr>
<td>Recording Multiple Takes</td>
<td>130</td>
</tr>
<tr>
<td>Choosing a Take</td>
<td>132</td>
</tr>
<tr>
<td>Editing Multiple Notes Simultaneously in the Editor</td>
<td>136</td>
</tr>
<tr>
<td>Project Tasks</td>
<td>140</td>
</tr>
<tr>
<td>Copying Parts of a Song with the Arrangement Track</td>
<td>140</td>
</tr>
<tr>
<td>Project Tasks</td>
<td>145</td>
</tr>
<tr>
<td>Recording Multiple Tracks</td>
<td>146</td>
</tr>
<tr>
<td>Lesson Review</td>
<td>151</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lesson 5</th>
<th>Recording and Editing Audio Tracks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preparing to Record Audio Tracks</td>
<td>153</td>
</tr>
<tr>
<td>Setting Project Properties</td>
<td>154</td>
</tr>
<tr>
<td>Working with New Audio Track Settings</td>
<td>154</td>
</tr>
<tr>
<td>Following an Audiobook Narration Recording Session</td>
<td>160</td>
</tr>
<tr>
<td>Removing Parts of a Region in the Audio Editor</td>
<td>164</td>
</tr>
<tr>
<td>Project Tasks</td>
<td>169</td>
</tr>
<tr>
<td>Editing a Multitake Audio Region</td>
<td>174</td>
</tr>
<tr>
<td>Splitting Regions in the Timeline</td>
<td>175</td>
</tr>
<tr>
<td>Deleting Unused Takes from a Multitake Region</td>
<td>178</td>
</tr>
<tr>
<td>Bonus Vocal Recording and Editing Exercises</td>
<td>183</td>
</tr>
<tr>
<td>Lesson Review</td>
<td>185</td>
</tr>
<tr>
<td>Lesson Review</td>
<td>186</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lesson 6</th>
<th>Working with Electric Guitars</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opening the Recording Session Project</td>
<td>189</td>
</tr>
<tr>
<td>Following an Electric Guitar Recording Session</td>
<td>190</td>
</tr>
</tbody>
</table>
Contents

Exploring the Default Electric Guitar Track Effects ........ 195
Using Stompboxes in the Pedalboard ....................... 198
Moving a Region to Different Tracks to Change Effects Patches .......... 206
Exploring Amp Designer ........................................ 209
Building and Saving a Custom Amp Model .................. 216
Doubling a Guitar Track ....................................... 222
Splitting a Guitar Region to Create Dynamic Change .......... 223
Working with Multiple Takes Electric Guitar Regions .......... 227
Project Tasks ..................................................... 228
Recording Electric Guitar Tracks—Without a Guitar .......... 229
Recording Your Own Electric Guitar Tracks .................. 231
Review Questions ............................................... 237

Lesson 7
Creating Drum and Percussion Tracks ....................... 239
Control Timing with Groove Tracks ......................... 240
Following the Rhythm of Another Track ...................... 244
Recording Multipass Drum Beats ............................. 246
Recording Arpeggiated Drum Machine Beats ................ 251
Project Practice ................................................... 253
Preparing the Project ............................................. 253
Making Recorded MIDI Regions Loop Ready ................ 254
Making Recorded Audio Regions Loop-Ready ................ 257
Project Practice ................................................... 264
Adding Regions to the Loop Library ........................ 264
Working with the Tempo Track ................................ 267
Project Tasks ....................................................... 270
Lesson Review ..................................................... 271

Lesson 8
Mixing Music and Adding EQ Effects ....................... 273
Evaluating a Rough Music Mix ................................ 274
Panning Tracks ..................................................... 275
Working with EQ Effect Presets ............................... 276
Evaluating the Master Output Level .......................... 279
Working with Volume and Pan Automation Curves .......... 280
Preparing the Project and Reconnecting a Movie File ....... 283
Lesson 9

Sharing Your Finished Projects .................. 295
Sharing with Other Apple Applications .......... 296
Sharing a Ringtone to iTunes .................... 300
Sending a Song to SoundCloud ................... 301
Exporting a Project as a Movie .................. 302
Fading Out the Master Track ...................... 303
Exporting Songs to Disk ............................. 304
Opening and Saving Projects via iCloud .......... 304
Project Tasks ........................................ 305
Lesson Review ...................................... 307

Bonus Lesson 1:
Learning to Play Piano
and Guitar with GarageBand ...................... Online

Bonuses:
Working with GarageBand for iOS ................. Online

Index ......................................................... 308

See last page of this eBook for instructions on downloading your lesson files.
Welcome to the official training course for GarageBand, Apple's totally redesigned and more-powerful-than-ever music recording and arrangement software. This book is for everyone from the beginner just curious about music creation to the seasoned professional who happens to be new to GarageBand. Even if you have been using the previous versions of GarageBand for years, this book is packed with all-new projects and features that you’ll want to learn.

Leave all apprehension behind. This isn’t a manual that goes step-by-step through every button, instrument, and preference. Nor is it a cursory tour that detours at will through GarageBand with no particular direction in mind. Rather it is a guided, in-depth, hands-on workshop to immerse you in GarageBand and many of the application’s exciting and powerful recording, arranging, music-making, fixing, mixing, and sharing tools.

You don’t need a background in music or any musical instruments or equipment other than a Mac. However, if you happen to have some instruments around, you’ll be invited to play and record them. And for those of you who have always dreamed of learning to play piano or guitar, Bonus Lesson 1, “Learning to Play Piano and Guitar with GarageBand,” walks you through GarageBand’s first learn-to-play lesson.
There is also a bonus GarageBand for iOS overview lesson that shows you how to create projects, change instruments, record, add loops, mix, save, and share your GarageBand for iOS projects via iCloud. You can find both bonus lessons online on the same page as the lesson files.

**What GarageBand Does for You**

Recording, arranging, and sharing original music were once daunting and costly endeavors that required a lot of money, time, and resources to accomplish.

GarageBand allows you to create music your way, at your own pace, giving you all of the tools you need to accomplish your finished song with no time pressure, budget restraints, or critics to hinder your progress. Best of all, GarageBand offers tools for fixing timing, pitch, and groove to improve your recorded performances.

With GarageBand and your Mac, you have a fully functioning recording studio and music workshop. How is it a workshop? Because you can also learn to play piano or guitar, design and build your own electric guitar amp and pedalboard with stompboxes, and create customized effects. Using GarageBand as a recording studio, you can attach a MIDI keyboard to play and record MIDI Software Instruments—or simply play your computer keyboard with Musical Typing. You can connect an electric guitar or bass directly through the Audio-in port or through a third-party audio interface depending on your Mac inputs and configuration. Or you can use the built-in mic on your Mac to record your instrument or vocals. Regardless of the input, once you record your tracks you can easily edit your recordings, add effects, and arrange and mix your music. If you like writing songs, you can just record your rough tracks and use the handy Note Pad to jot notes or lyrics. There's even a dictation feature so you can speak your lyrics and they will be typed for you.

You may already use your Mac for communication with friends and family through email and to collect and organize your photo and movie memories with iPhoto and iMovie. Chances are iTunes already holds and organizes all your favorite songs. Why not add a playlist of your own original music? With GarageBand on your Mac, you can fulfill your musical aspirations as well and share the finished songs to iTunes, iCloud, or even the world through SoundCloud.

This book isn't about learning software and memorizing shortcuts, menus, and buttons. It's about creating music, working with music, building music, and making all types of music sound great. As you explore different projects ranging from a little dog-walking
ditty (recorded on an iPhone while walking a dog—really) to a recording session with a professional guitarist, to creating a loopy ringtone, you’ll end up learning the shortcuts and software along the way.

**The Methodology**

This book emphasizes hands-on training. Each exercise is designed to help you learn the application inside and out, starting with the basic interface and moving on to advanced music editing, arranging, and mixing techniques. If you are new to GarageBand, it would be helpful for you to start at the beginning and progress through each lesson in order, since each lesson builds on information learned in previous ones. If you are already familiar with GarageBand, you can start with any section and focus on that topic. However, since GarageBand has been totally redesigned, even the seasoned GarageBand users will discover new features and insights in the earliest lessons.

The projects you’ll work with were carefully designed as practical exercises. They aren’t big-budget music recordings to show off the software. These are real-life examples, created with real people and no additional budget to demonstrate some of the range of projects you can do yourself with GarageBand.

**GarageBand Course Structure**

Each of the nine lessons in this book focuses on a different aspect of creating projects with GarageBand. Each lesson expands on the basic concepts of the program, giving you the tools to use GarageBand for your own projects.

The lessons in this book can be informally divided into seven sections:

- Lessons 1–2: Learning the interface and working in the timeline.
- Lesson 3: Working with pre-recorded Apple Loops and arranging music
- Lessons 4–7: Recording, editing, and adding effects to different types of instruments and tracks, including MIDI Software Instruments, vocal audio tracks, electric guitar, and drum and percussion tracks
- Lesson 8: Mixing and adding EQ effects to complete a project
- Lesson 9: Sharing your finished projects
- Bonus Lesson 1: Learning to Play Piano and Guitar with GarageBand
- Bonus Lesson 2: Working with GarageBand for iOS—an overview of recording, playing, and sharing music on your iOS device
Getting Started

System Requirements

This book was written using GarageBand 10 on OS X Mavericks. However, the project files and lessons are compatible with both Mavericks and Yosemite operating systems for the Mac. If you have an older version of GarageBand, you will need to upgrade to the current GarageBand version to follow along with every lesson. At the time of this printing, the GarageBand software is free with any new Macintosh computer and OS X Mavericks.

The free version of GarageBand includes one Drummer, 50 Software Instrument sounds, and 500 loops. There is an optional one-time GarageBand in-app purchase that includes an additional 17 drummers, 150 software instrument sounds, and 1,500 loops.

The step-through exercises in this book do not require the purchased upgrade. The system used to create the projects in this book was fully loaded with the in-app purchase so the screenshots may not always match your screen.

Occasionally, there will be a bonus exercise, or a sample of a finished version of a song where I took advantage of the additional sounds and loops. You will be advised in those cases that if you have the additional download installed, you can open up a sample project to see and hear my final version of the project. In some cases, such as the electric guitar recording session project in Lesson 6, there will be two versions of the project. One version will include the drummer track that the guitarist used for his actual recording. The other version will include the default drummer track that does not require the in-app purchase. Regardless, both versions of the project will follow the identical steps and include the identical regions.

Before you begin the lessons in this book, you should have a working knowledge of your Mac, OS X, your iPhone or iPad, and iOS 7. You don’t need to be an expert, but you do need to know how to use the mouse and standard menus. Those of you with GarageBand for iOS who wish go through Bonus Lesson 2 should have a basic knowledge of how to use your iPhone or iPad and how to use an iOS 7 touch screen.

What do you need to know about your Mac before starting? It would be helpful if you are comfortable with opening, saving, and closing apps and files on the Mac, as well as how to tap, swipe, and click your mouse or trackpad. You will need a working understanding of how OS X organizes files on your computer. If you need to review any of these techniques, see the printed or online documentation that came with your device.
Copying the GarageBand Lesson Files

The Apple Pro Training Series: GarageBand lesson files must be downloaded to your Mac in order to complete the lessons in this book. After you save the files to your hard disk, each lesson will instruct you in their use.

To download these files, you must have your book’s access code, which is provided on a card in the back of the printed editions of this book and on the “Where Are the Lesson Files?” page in electronic editions.

For complete download instructions, see “Downloading GarageBand Projects for This Book” in Lesson 1.

Resources

Apple Pro Training Series: GarageBand is not intended to be a comprehensive reference manual, nor does it replace the documentation that comes with the application. Rather, the book is designed to be used in conjunction with other comprehensive reference guides. These resources include:

▶ The companion Peachpit website: As GarageBand is updated, Peachpit may choose to update lessons as necessary. Please check www.peachpit.com/aptsgb.
▶ The Apple website: www.apple.com
▶ Apple Pro Training Series: iPhoto (Peachpit, 2014), by Dion Scoppettuolo, is an excellent companion to this book. Learn how to use iPhoto to enhance your photos, create slideshows, and print keepsake photo books on both Mac OS X and iOS.
▶ Apple Pro Training Series: iMovie (Peachpit, 2014), also by Dion Scoppettuolo, is an excellent companion to this book. Learn how to use iMovie to create first-class movies, advanced slideshows, and fun movie trailers on both OS X and iOS.
Acknowledgments

We would like to thank the following individuals for their contributions of media used throughout the book:

Casey Brassard, for playing along with his guitar in the “Learning to Play Piano and Guitar with GarageBand” and “Working with GarageBand for iOS” bonus lessons.

Tina Sacco, for her award-winning poems “Life’s Flower” and “Groundhog Day,” as well as her spoken voice reading of her work.

Chad Waronicki, for his electric guitar riffs and expertise.

Lauren Diaz and Brooke Bingham, for letting us record and use their award-winning hip-hop dance, as well as choreographer William Blair and Tonya Matheny for her support and use of the Ready Set Dance studio.

Kathryn Perez, for her wah-vocal and kazoo recordings used in the recording electric guitar without a guitar section.

Klark Perez, for editing the Lexie walking and RSD The Step Off video clips used in this book.

Ben Estes, for his insights and suggestions as well as the Follow and Groove Track demo projects.

Colby Stiltz, for his hip-hop tempo tips and tricks.

The amazing Peachpit team: Eric Schumacher-Rasmussen, Liz Welch, Nancy Peterson, Darren Meiss, and Kim Wimpsett, for their input and efforts in crafting this book.
This lesson takes approximately 90 minutes to complete.

**Goals**

- Record a Software Instrument take
- Fix the timing of notes in the Piano Roll Editor
- Record multiple takes of a bass part
- Choose a take
- Edit multiple notes at once in the Piano Roll Editor
- Use arrangement markers to copy parts of a song
You already have a basic understanding of the GarageBand window, and you have some experience working with tracks. Now it’s time to dive in and start filling those tracks with custom music that you create with Software Instruments.

In this lesson, you’ll learn recording and editing techniques for building music with Software Instrument regions. You’ll also learn how to change instruments for Software Instrument tracks in the timeline.

You have four ways of recording Software Instrument parts into the timeline: single-take recording, multiple-take recording, multiple-track recording, and overdub recording. You’ll work with the first three methods in this lesson. Along the way you’ll also learn how to edit and fix timing on your Software Instrument recordings. You’ll explore the fourth option, overdub recording, in Lesson 7, “Creating Drum and Percussion Tracks,” when you use it to record an original hip-hop beat.
Preparing the Project

Let’s take a moment to open and save the first project for this lesson before moving on to the main exercises.

1. Open the project 4-1 Ditty Bass Part 1 from the Lesson 4 folder.
2. Save it to your My GarageBand Projects folder on the desktop.
3. Play the project once and listen closely to the bass parts that you will be recording shortly.

This is the same project you worked with in Lesson 2, “Working with Tracks.” The difference is that there’s a new section at the end that will be used as a bridge between the second verse and second chorus. Those parts have not yet been created. At the end of this lesson you’ll use the arrangement track to duplicate parts of the song to build it up to a full song length.

There’s just one catch you should be aware of before you get started.

Using Catch Mode to Keep the Playhead Visible

While you record or edit your finished recordings, it’s a good idea to be able to see the playhead at all times. When Catch mode is on, the visible section of the tracks area or editor follows the playhead during playback and recording. If Catch mode is turned off, the playhead moves past the right edge of the visible portion of the window because the window doesn’t update.
Independent Catch buttons in the tracks area, Audio Editor, and Piano Roll Editor menu bar allow you to turn Catch mode on or off.

Let’s look at the project with Catch mode on and off so you understand how it works.

1. Press Command-Right Arrow or drag the horizontal zoom slider in the tracks area to the right to zoom into the timeline until you can see only the intro and the beginning of the verse parts of the song.

2. Check to see if Catch mode is on (the Catch button is blue). If not, click the Catch button to turn on Catch mode.

3. Start playback and watch the playhead. When it gets to around the middle of the tracks area, the playhead remains stationary while the tracks scroll underneath the playhead.

4. Continue playback. Click the Catch button to turn off Catch mode. The playhead continues moving off the right side of the screen.
5 Click the Catch button again to “catch” the playhead so that it displays on the screen. The playhead will gradually work its way back to the middle of the tracks area while always staying visible, with the regions scrolling beneath it. When you reach the last measures of the song, the playhead moves toward the right until it reaches the end-of-project marker.

6 Zoom out of the timeline until you can see all the regions in the tracks area again.

Now that you know how Catch mode works, you can make sure it is on when recording in the timeline. That way, you can keep an eye on the recording in real time as it forms a region in the timeline.

Single-Take Recording

A single-take recording begins on a selected track at the playhead position and continues until you stop recording. This is an excellent recording method when you’re practicing or just want to quickly record a musical riff, melody, or idea so you don’t forget it.

The result is a single region containing whatever notes were played while recording. This method is similar to recording video or using a voice recorder: The hardest part is the performance. Of course, with Software Instrument recordings every part of the recording is editable, so no worries. Also, you’ll use keyboard shortcuts whenever possible to keep your hands on your instrument (computer keyboard) rather than a mouse or trackpad.

In the next series of exercises you’ll create a single-take recording of the bass part for the Dog Walk Ditty’s first verse. Let’s get started:

1 Select the Fingerstyle Bass track header. The region within that track is the Fingerstyle Bass part that you will record.

2 Press Command-D to duplicate the selected track. An empty Fingerstyle Bass track appears in the timeline below the original track.
This is the track where you will record your bass part.

3 Press C or click the Cycle button to show the yellow cycle area on the top half of the ruler. The cycle area should be from bar 9 to bar 17.

NOTE ▶ If for some reason you do not already have a cycle area between bars 9 and 17, drag the cycle area to create one.

4 Press the Up Arrow key to select the first Fingerstyle Bass track. Press S to solo the selected track. Press E to show the selected region in the Score Editor.
5 Press the Spacebar to start playback and listen to the bass part. Follow along with the playhead in the editor as it plays the notes in the Fingerstyle Bass region. The part is very simple to play (by design). Let’s give it a try using your computer keyboard.

**Playing Music with Your Computer Keyboard**

You can play and record Software Instruments using an external MIDI music keyboard, the onscreen keyboard, or musical typing. In the exercises for this lesson, you’ll use musical typing to turn your Mac computer’s keyboard into a fully functional MIDI keyboard.

The Musical Typing keyboard shows which musical keys correspond with the keys on your computer keyboard. Notice that the Tab key works as a sustain pedal. The Z and X keys will modulate the octave lower and higher, respectively, while C and V lower and raise the velocity (the relative volume is based on how hard you strike the key). You can click the keys on the Musical Typing window with your cursor or play them on your computer keyboard.

1 Choose Window > Show Musical Typing or press Command-K. The Musical Typing window appears over your workspace. Luckily, it is a floating window so you can move it anywhere you’d like on your screen.

**NOTE** You can click the notes in the Score Editor to see the name (key) of each note and octave. C2 is Middle C on the keyboard. C3 is one octave higher, C1 is one octave lower, and so on. The blue area on the mini keyboard at the top of the Musical Typing window shows which octave is active in the window.
2 Drag the Musical Typing window below the Fingerstyle Bass track header so that you can still see the Fingerstyle Bass region in the track and the notes in the Score Editor.

3 Start playback. The notes on the Musical Typing keyboard darken as they are played. Watch carefully to see the pattern of the notes that are played.

The good news is that I intentionally composed this part so it would be easy to play and remember. All you have to do is play the middle keys on your computer keyboard sequentially: A, S, D, F, G, H, J, K, L. They correspond with the musical notes (the first eight white piano keys) shown on the Musical Typing keyboard: C, D, E, F, G, A, B, C.

4 Stop playback. Press each of the keys on your keyboard in order: A, S, D, F, G, H, J, K, L. Now that you've played the notes, you can practice the timing.

5 Click the Metronome button in the toolbar to turn on the click track.

**NOTE** The shortcut K to turn on or off the metronome won’t work when the Musical Typing window is displayed because K is one of the keyboard keys used to play music. The same applies to any keyboard shortcuts that consist of a letter without a modifier key.
Start playback and practice along with the prerecorded bass part. You can use the audio of the Fingerstyle Bass track and the visual of the playhead moving over notes in the Score Editor as guides. Un-solo the Fingerstyle Bass track and practice a few times with the full song. When you are ready to record, stop playback.

It’s time to lay down a track. That’s musician-speak for recording an instrument onto a track.

**Recording a Single Take in the Timeline**

You have all the skills to record this part. All you need to do is hide the editor, turn off Cycle mode, and set your count-in. Cycle mode is used for mult-take and overdub recording. Although using the cycle area was useful for practicing your part, it must be turned off to perform a single-take recording. Remember, many keyboard shortcuts do not work while the Musical Typing window is open, so you’ll need to manually click the buttons to turn off Cycle mode and hide the editor.

1. Click the Cycle button to turn it off.
2. Click the Editors button to hide the editor.
3. Drag the Musical Typing window to the bottom of the tracks area.
The last thing to do before recording is set a “count-in” so that the metronome will click for one full bar (four clicks in this case) or two full bars (eight clicks) before the actual recording begins. The count-in gives you a “one-two-three-go” so that you don’t have to start playing the instant you click Record. The Count-In button is on the left side of the Metronome button and turns purple when it is turned on.

4 Click the Count-In button to turn it on and set the count-in to two bars so you will hear eight clicks before you start recording.

5 Choose Record > Count-In > 2 Bars.

6 Make sure the empty Fingerstyle Bass track is selected.

7 Click bar 9 on the ruler to move the playhead to that position.

In GarageBand, the color red is only used for recording. During a recording, the record button turns red, whereas a red region appears in the timeline as you record to represent the live recording. Also, the playhead turns red during recording, as does the LCD display during recording count-in.
Starting the instant you click Record, the playhead will move back two measures from its current position. You will hear the count-in for eight beats as the playhead moves across the two bars in the ruler toward the record-start position. Time to record—good luck!

8 Click the Record button in the transport controls on the toolbar. Record the bass part that you practiced. A red region appears in the selected track as you record. The region doesn’t appear until you record the first note. When you are finished recording, press the Spacebar to stop recording.

![Record and Edit Software Instruments](image)

Notice that the newly recorded region changes from red to green, indicating it is a Software Instrument region.

9 If you don’t like your recording and want to try again, press Command-Z or choose Edit > Undo Recording. Repeat step 8.

10 Press Command-S to save your finished recording. Close the Musical Typing window.

**NOTE** ➤ Saving is an important part of recording because it saves the recording with the project file. You still have the option to delete or edit the region at another time.
The recorded region is named after the track and should look a lot like the original Fingerstyle Bass region in the track above it.

11 Mute the original Fingerstyle Bass track. Listen to your recording with the rest of the tracks. How does it sound?

Don't worry if it isn't perfect; you'll fix the timing in the Piano Roll Editor next.

Fixing Notes in the Piano Roll Editor

Previously, you used the Score Editor as a guide while you practiced the bass part. For this exercise you'll work with the Piano Roll Editor to modify the length and position of the individual bass notes to fix any timing issues your recording may have.

NOTE ▶ If you did not complete all of the previous exercises in this lesson, open the project 4-2 Bass 1 Recorded and save it to your projects folder. In this version of the exercise, you'll work with a bass part that I recorded.

1 Move the playhead to bar 9 in the timeline.

2 Select the Fingerstyle Bass track containing your new recording.

3 Press E to display the Score Editor. Click the Piano Roll button to display the Piano Roll Editor.
4 Swipe over the region in the Piano Roll Editor display area left or right, or drag the horizontal slider at the bottom of the editor (which appears when you swipe) to position the beginning of the region (bar 9) at the beginning of the visible area of the editor. Also adjust the horizontal zoom slider in the editor or pinch on your touchpad as needed until the grid shows each beat in the measure. The beats are listed in the editor ruler as a decimal point after the bar number, such as 9.3 for the third beat of bar 9.

![Piano Roll Editor screenshot](image)

Human performances usually aren't perfect. Sometimes the imperfections in music add subtle nuances and feeling to a song. In fact, you probably could get away with your recording as is, with no additional editing. However, since you need to learn how to edit anyway, let's fix it.

Each note (represented by a green bar in the Piano Roll Editor) should start exactly on a beat. The long notes should start exactly at the beginning of a measure (bar). To fix the timing or position of a note in the Piano Roll Editor, you simply click and drag the note in the middle to move it, and on the edge to trim or lengthen it.

5 Drag the first note in the region to the left until it starts at the first beat (beginning) of bar 9. Chances are, your first note will not look exactly like the one shown in the screenshot. Regardless of its length, you'll need to move the first note to the beginning of bar 9.

![Piano Roll Editor screenshot](image)
Notice that when you select a note, the Notes tab at the top of the Piano Roll Editor inspector turns blue.

6 Drag the second note to the fourth beat of bar 9 (9.4).

**NOTE** If your second and third notes are significantly shorter or longer than a quarter of a beat, you can trim the edges so that they fit between the gridlines, like the notes pictured in the screenshots.

As you can see, fixing notes individually is not difficult. However, if you are working with a long region or a lot of notes, this process can become rather tedious.
Quantizing Notes in a Region

Rather than manually moving each and every note in a region to fix the timing, you can *quantize* the timing. Quantizing is a digital music term for automatically fixing timing based on set parameters. In this case, GarageBand will automatically move all the notes to the nearest gridline based on the settings in the Piano Roll Editor inspector.

You can use the Time Quantize button to fix the timing of all the notes in an entire region or selected notes. These timing changes are nondestructive. The original timing is never lost, so you can turn off Time Quantize at any time to return to the original recorded timing.

One thing to keep in mind is that the Time Quantize feature is selection based. If you have a note selected, only that note will be fixed. To fix all the notes in a region at once, you need to first deselect any notes. The Piano Roll Editor inspector controls change depending on whether you have a region (all notes) or individual notes selected. The Region or Notes tabs change automatically based on your selections.

1. Click any empty space in the editor display area to deselect all notes within the region. The top of the inspector shows which items will be modified.

2. In the Piano Roll Editor inspector, type *My* in the Region Name field so that the name of the region changes to *My Fingerstyle Bass*. Press Return to implement the change. This will help distinguish your recording from the one provided in the starting version of the project.
NOTE: The top of the Piano Roll Editor inspector shows what is currently selected, and therefore what will be modified by changes to the controls. If your inspector shows no regions selected, go up to the timeline and select the My Fingerstyle Bass region.

3 In the Piano Roll Editor inspector, click the Time Quantize pop-up menu and choose 1/16 Note. Perfect timing—instantly!

The Strength slider is only available when an entire region is selected. Leave the Strength slider set to 100. Lowering the strength decreases the amount of quantization.

4 Press E to hide the Piano Roll Editor. Press K to kill the click track (to turn off the metronome).

5 Play the project from bar 9 to 17 to hear your edited recording in action. Well done!

Now that your recording is finished, you don't need the original Fingerstyle Bass track. To delete the track, let's use the shortcut menu in the track's header.

6 Control-click (or right-click) the track header for the top Fingerstyle Bass track. Choose Delete Track from the shortcut menu. Click OK in the warning dialog that says “There are regions in this track!”
Save your progress.

Project Tasks

You’ve successfully recorded a single-take Software Instrument Bass part. In a few minutes you’ll work with the Smart Controls and the arpeggiator to record a more complex bass part using multiple-take recording. For now, you’ll hone your current skills to learn and practice the new bass part.

Create a cycle area from bar 17 to 25. Display the Note Pad to see which notes you need to play for the Bass Part 2 Chorus. Open the Musical Typing window and play the new part along with the song. Use the Score Editor to look at the notes you need to play. Remember that you are just learning the individual notes. You’ll add the arpeggiator in the next section.

The keys you will be playing on your computer keyboard/Musical Typing window are K, G, F, K, A, F, K. Once you have practiced the part, stop playback.
**Working with Smart Controls and the Arpeggiator**

For the second bass recording, you’ll work with the arpeggiator to create a bass part that accompanies itself. The arpeggiator plays a sequence of notes for every note you press. If you play a chord, each note of the chord is played a note at a time in the specified pattern or preset. The best way to get a feel for the arpeggiator is to explore the settings already applied to the region in the Fingerstyle Bass Arpeggiator track. Keep in mind that the arpeggiator is applied to an entire track, not the specific region, so any region that you add or any playing you record to an arpeggiated track will play the arpeggiated pattern unless you turn it off.

1. Close the Musical Typing window to make more room in your workspace.
2. Select the Fingerstyle Bass Arpeggiator track header, if it is not already selected.
3. In the toolbar at the top of the window, click the Smart Controls button.

The Smart Controls pane replaces the editor at the bottom of the window.
The controls that look like they are mounted on a bass guitar can be used to adjust the sound of the instrument, but you can ignore them for now. For this exercise you’ll focus on the Arpeggiator button and Arpeggiator pop-up menu located in the upper right of the Smart Controls pane.

4 Solo the Fingerstyle Bass Arpeggiator track. Start playback. What you hear is the sound of the Groovy Cycle 01 Arpeggiator preset.

5 Continue playback. Click the Arpeggiator button to turn it off. The notes play one at a time, just as you practiced them in the project tasks.

6 Click the Arpeggiator button to turn it back on. Stop playback.

7 Click the Arpeggiator pop-up menu to see the various options.

- Note Order is the direction of arpeggiated notes.
- Rate is the note value for arpeggiated notes based on the song tempo.
- Octave Range is how many octaves the arpeggio covers.
- Arpeggiator Presets are listed below the line starting with Classic Cycle 01.

8 Start playback. Try several arpeggio presets. They all sound pretty good. When you are finished trying presets, choose the Groovy Cycle 01 preset. Stop playback.

Now that you know how to turn on the arpeggiator and change the preset, you’re ready to record.
Preparing the Project

You still need to create a track to record your second bass part for the chorus section of the song. Let’s go ahead and rename the track. Also, it wouldn’t hurt to practice one more time before recording.

1. Select the Fingerstyle Bass Arpeggiator track if it is not already selected.

2. Press Command-D to duplicate the track.

3. Control-click (or right-click) the new track’s header and choose Rename Track from the shortcut menu. Type *My Arpeggiator Bass* in the track’s name field. Press Return to set the new name.

4. Look at the Smart Controls pane for the new track. Notice that the Arpeggiator settings are already on and ready to go. That’s because duplicating a track also duplicates the track’s instrument and settings. Did you notice that the new track was soloed because the track you duplicated had the Solo button on at the time you created the duplicate track?

5. Press B to hide the Smart Controls pane. Press Command-K to open the Musical Typing window.

6. Move the Musical Typing window to the empty space at the bottom of the tracks area where the editors and Smart Controls would be if they were showing.

7. Start playback and practice the part a few more times using the Note Pad as a reminder of which notes (keys) to play (type) on the Musical Typing keyboard.
If practicing or recording with an arpeggiated Software Instrument is distracting you from concentrating on your performance timing, you can always turn off the arpeggiator in the Smart Controls and then turn it back on after you record.

8 Save your progress.

It’s time to try recording multiple takes of the arpeggiator bass part. The good news is that with multiple takes, you can pick which take you want to use and still edit it to fix any performance issues you may have while recording.

**Recording Multiple Takes**

Multiple-take recording means you can record multiple versions (takes) in succession. Once you stop recording, you can preview the various takes and choose which one you want to use in the project.

The secret to multiple-take recording involves the Cycle Recording preference and the cycle area in the timeline. During multiple-take recording, a new take is recorded each time the cycle repeats. Let’s try it.

**NOTE** If you did not complete all of the previous exercises in this lesson, open the project **4-3 Bass Part 2** and save it to your projects folder. Also, you’ll need to Press Command-K to show the Musical Typing window before continuing on with the next step.
1. Choose GarageBand > Preferences.

2. In General Preferences, make sure Cycle Recording is deselected.

![Preferences](image)

If Cycle Recording is selected, each recording cycle is combined within one take. You’ll try this in Lesson 7, “Creating Drum and Percussion Tracks,” to create a complex drum beat. With Cycle Recording deselected, you will record a new take with each cycle.

3. Close the General Preferences.

4. Turn on the metronome.

5. Select the My Arpeggiator Bass track if it is not already selected. Recordings always go to the selected track.

![GarageBand Interface](image)

Your goal is to record at least four full takes before you stop recording. Four takes will give you plenty to choose from when you need to select the best take.
Click the Record button to begin multiple-take recording. You will hear the count-in before recording starts. Play the bass part on your computer’s keyboard. After at least three full cycles, stop recording. You are welcome to record more takes if you wish. With each cycle you will see a red region for the live recording, whereas a green region remains underneath for the previous finished take.

Take a look at the finished multiple-take region. The number in the upper-left corner of the region shows the current take number. The name of the region is the same as the name of the track, with the addition of a decimal point and take number at the end. In this case, it reads My Arpeggiator Bass.4.

Turn off the metronome. Close the Musical Typing window and hide the Note Pad.

Save your project.

You’ve finished recording multiple takes of the second bass part. In the next section you’ll choose a take to use in the finished project.

Choosing a Take

After you’ve recorded a multiple-take region, you can use the Takes pop-up menu in the upper-left corner of the region to change to a different take. In this exercise you’ll evaluate the different takes and choose the one closest to the original Fingerstyle Bass part that you used as a guide. Later, you can fix the timing of the performance in the Piano Roll Editor.

**NOTE** ► If you did not record a multiple-take region in the previous exercise, open the project **4-4 Bass Part 2 Recorded** and save it to your projects folder.
1 Select the multiple-take region in your timeline and press Command-Right Arrow or the horizontal zoom slider to zoom into the region until it is easy to compare the notes (dashes) in the multiple-take region with the Fingerstyle Bass guide region.

2 In the upper-left corner of the multiple-take region, click the number (4 in the screenshot) to open the Takes pop-up menu. The Takes menu lists each take, along with an option to delete unused takes or delete the current take. From the Takes menu, choose Take 1.

3 Listen to Take 1 with the other bass part. Then unsolo both arpeggiator bass tracks, and mute the original Fingerstyle Base Arpeggiator track. Listen to your bass part with the rest of the tracks.

4 Choose each take and listen to it with the song. If needed, solo your take with the original arpeggiator bass track to hear them together. When you have determined which take is best, keep it selected and move on to the next step.

**NOTE** ➤ If you are working with the prebuilt project *4-4 Bass Part 2 Recorded, Take 1* is the best take.
5 Double-click the multiple-take region with the best take showing to open it in the Piano Roll Editor.

![Piano Roll Editor](image)

**NOTE** ▶ If the Score Editor opens, click the Piano Roll button to switch editors. If you don’t see the selected region in the Piano Roll Editor, click the Catch button in the upper-left corner of the editor and start playback. If you don’t see any dashes (MIDI notes) on the grid, you may be looking at the wrong octave range within the region in the editor. Swipe up or down until you see the C3–C2 octave range in the visible area. Use the vertical keyboard at the left of the editor as a guide.

Look at the notes in the Piano Roll Editor to see where they begin. Chances are, the notes do not begin precisely at the beginning of bars or beats as they should.

6 Adjust the horizontal zoom slider in the editor until you see each beat in the ruler, four beats (indicated with decimal points) per measure.

![Adjusted Zoom](image)

Each note starts at the beginning of a measure (bar), so you can quantize the notes to the nearest 1/4 note (beat).
7 Select the first note, and choose “1/4 note” from the Time Quantize pop-up menu.

The selected note moves to the beginning of the 17th measure (bar 17).

8 Press Command-A, or choose Edit > Select All to select all the notes in the region. The top of the Piano Roll Editor inspector shows that eight notes have been selected. Click the Q (Quantize button) to apply 1/4 note quantizing to all of the selected notes.

All of the selected notes move into position so they start precisely at the beginning of each measure.
9. **Zoom out of the Piano Roll Editor until you can see all the notes in the region to inspect their quantized positions.**

```
9. Zoom out of the Piano Roll Editor until you can see all the notes in the region to inspect their quantized positions.
```

Perfect!

10. **Press E to hide the editor.**

11. **Delete the Fingerstyle Bass Arpeggiator track. Click OK in the warning dialog.**

12. **Turn off Cycle mode.**

13. **Adjust the zoom level in the tracks area until you can see all the regions.**

14. **Save your project.**

```
10. Press E to hide the editor.

11. Delete the Fingerstyle Bass Arpeggiator track. Click OK in the warning dialog.

12. Turn off Cycle mode.

13. Adjust the zoom level in the tracks area until you can see all the regions.

14. Save your project.
```

All the bass parts have been recorded and the workspace is displaying only the tracks area and headers. It’s time to finish this song.

**Editing Multiple Notes Simultaneously in the Editor**

To complete this song, your next task is to clean up the busy strings regions. If you recall, the regions in the String Ensemble track are duplicates of the iOS Smart Guitar regions. The busy guitar fingering works fine for the guitar, but it is too much for strings in this song. In this exercise, you’ll open the first strings region in the Piano Roll Editor, and then select and delete all of the notes in the middle of the grid. That way, all you are leaving are the highest and lowest notes. Let’s give it a try.
NOTE ▶ If you did not complete all of the previous exercises in this lesson, open the project **4-5 Edit Strings** and save it to your projects folder.

1 Select the String Ensemble track header. Press E to open the selected track in the Piano Roll Editor.

2 Adjust the horizontal zoom in the editor until the first region (Part A iOS Smart Guitar) fills most of the visible area.

3 Drag the top edge of the Piano Roll Editor upward to expand the editor and give you more room to work.
Remember, your goal is to delete middle notes; you’ll keep the highest and lowest notes.

Delete the selected notes shown here

4 In the Part A region in the editor, click the empty grid above the first played note at the beginning of bar 5. Be careful not to click the edge of the region in the editor or you will trim the beginning of the region.
5 Drag up and to the right across the middle notes as shown to select them all at once.

6 Press Delete. The notes are removed from the region.

**NOTE** You can also click to select individual notes, or drag across a smaller group of notes to delete them in smaller sections if it is easier. The end result will sound the same.

7 Play the first part of the song to hear the edited strings region.

8 Save your progress.

Wow. The strings part sounds so much better. Instead of competing with the guitar part, it now feels like a supporting track.
Project Tasks

Now that you know how to clean up extraneous notes in the Piano Roll Editor, you can work on the Part B and Part C regions in the String Ensemble track. Use your best judgment when selecting “middle” notes and deleting them. The good news is that every note works, so if you delete too many or too few it will still sound great. Remember, you are just making it sound less busy. Play the song to hear the edited string regions with the rest of the song.

Edited regions with fewer notes.

When you are finished, drag the top edge of the Piano Roll Editor down to the lower third of the window. Don't forget to save your work and close the editor.

Copying Parts of a Song with the Arrangement Track

In Lesson 1, “Working with a GarageBand Project,” you worked with arrangement markers in the arrangement track to rename the different sections of this song. Arrangement markers can also be used to move, copy, or delete parts of a song such as the chorus or verse. In this exercise you’ll create a new arrangement marker for the bridge section at the end of the song. Then you’ll copy and move the verse and chorus parts to lengthen the song. Finally, you’ll add an outro (end) to the song. All of this can be done with arrangement markers.

NOTE ▶ If you did not complete all of the previous exercises in this lesson, open the project 4-6 Arrangement Track and save it to your projects folder.
1. Click the Add button (+) in the arrangement track header to create a new arrangement marker. The new arrangement marker appears after the last arrangement marker currently in the track (Chorus).

The new marker is already called Bridge, so you won’t need to rename it. The marker is, however, a bit too long for this piece, so let’s trim it to fit the part. First, you’ll need to move the little region at the end that isn’t actually part of the bridge.

2. Zoom into the bridge section of the timeline. The short region at the end is the last chord of the song. Drag the short region toward the right and place it at bar 36 to get it out of the way.
3 Drag the right edge of the Bridge arrangement marker to bar 29.

The bridge section of the song is now the same length as the bridge part.

It's time to start copying parts to build the full song. This song will have a total of seven parts: Intro, Verse, Chorus, Verse, Bridge, Chorus, and Outro.

4 Zoom out of the timeline as needed until you see the end-of-project marker at bar 46.

5 Option-drag the empty space on the Verse arrangement marker to the right and place the duplicate after the chorus at bar 25. Release the marker before you release the Option key.

Amazing. The arrangement marker and all of the regions within that section of the song are copied simultaneously.
6 Option-drag the Chorus arrangement marker to bar 37 so the copy starts after the bridge section.

Notice that the little part of the song that you moved out of the way continues to stay the same distance from the end of the song. It just keeps getting moved toward the right with each duplicate section.

The last section to Option-drag is the Intro, which will be repurposed as the Outro with a few minor modifications.

7 Option-drag the Intro arrangement marker to the end of the song and place the duplicate at bar 45.

8 Click the name Intro on the last arrangement marker and choose Outro from the pop-up menu.
9 In the Outro section of the song, drag the left edge of the region in the String Ensemble track to extend it to the beginning of the section (bar 45).

10 Extend the Verse drummer region in the second verse section to bar 37 so that the bridge will share the drummer region.

11 Move the drummer region in the Outro so that it starts at bar 45 and ends at 50.

12 Zoom in as needed to drag the short region (past the end-of-project marker) to the left and place it at the end of the Outro section in the Acoustic Guitar track (bar 53).

**NOTE** This final chord for the end of the song was not recorded. Rather, it was created in the Piano Roll Editor.
The end-of-project marker automatically moves one bar to the right of the last region in the song—in this case, bar 54.

13 Zoom out of the timeline until you can see the entire song. Play it once to hear how all of the parts work together. Save your project.

NOTE ▶ If you did not complete all of the previous exercises in this lesson and want to see the finished song, open the project 4-7 Finished Ditty and save it to your projects folder.

Congratulations. You recorded and edited two different Software Instrument bass guitar parts. Along the way you also trimmed excess notes from the strings parts and used the arrangement track to build the finished song.

Project Tasks

You may have noticed that the bridge section is missing strings and bass regions. Though traditionally the bridge of a song indicates a change, this one feels a little lacking. If you'd like to finish building the bridge section, feel free. Consider duplicating the guitar part to the strings and/or bass tracks. Then remove notes to clean it up. You could also try recording a new part using either single-take or multiple-take recording. Have fun. When you are finished, save your project.
Recording Multiple Tracks

The last recording feature you’ll explore in this lesson is recording to multiple tracks. For this feature, you’ll open the Keyboard project template. This is more of an experimental section to show you how to record to multiple tracks. One of the most common uses for multiple track recording is when you want to record a microphone with an instrument. In this example you’ll record a voice track with the built-in microphone while simultaneously playing and recording a software instrument track with the Musical Typing window. If you have a MIDI keyboard connected to the computer you can record with that device instead of Musical Typing.

You need an audio interface connected to the computer to record multiple audio instruments such as two guitars simultaneously. To record multiple software instrument tracks you will need to use an external audio interface or use the Audio MIDI Setup utility on your Mac to create an aggregate device.

**MORE INFO**  You can learn more about the Audio MIDI Setup utility by quitting GarageBand and opening the utility. Go to Go > Utilities > Audio MIDI Setup. Once the utility opens, go to the Help menu and read how it works.

What notes you play, and which Software Instruments you choose to record, will be up to you.

1. Choose File > New. Click the New Project button in the Project Chooser and choose the Keyboard Collection template. Click Choose.

The Keyboard Collection template opens.
2 Save the project as *Multi-track Recording Test* to your projects folder.

The project has the Smart Controls pane showing, along with many prebuilt empty keyboard tracks.

3 Press B to hide the Smart Controls pane.

4 Press Command-K to open the Musical Typing window.

5 Select the first track, and then play a few keys on the Musical Typing keyboard.

6 Press the Down Arrow key to select a track to hear how it sounds; repeat to audition additional tracks.

This project template is preloaded with a lot of different Software Instrument keyboard tracks so you can sample and compare them.

7 Select the track with the keyboard sound that you want to record. Click the Add Track button.

8 In the New Track dialog choose the Microphone icon to create an audio track using a microphone. In the Details pane at the bottom of the New Track dialog, leave the default Input setting (Input 1). Select the checkbox “I want to hear my instrument as I play and record” if it is not already selected. Don’t worry about the other settings at
this time. Click Create. You may see an Avoid feedback warning dialog that says you need to use headphones to avoid feedback. If so, click OK on the warning dialog.

![Software Instrument and Audio setup](image)

Next you need to set the input to your computer's built-in microphone. The easiest way to do that is through the GarageBand Preferences.

9 Choose GarageBand > Preferences. In the Audio/MIDI preferences pane, select Built-in Microphone from the Input Device pop-up menu. Your other Audio/MIDI preferences may differ from the screen shot depending on your system settings and equipment. Close Preferences.

![Preferences panel](image)

**NOTE** You can also set the Input for an audio track in the Smart Controls inspector.
The new audio track you created should be in the timeline directly below the track you selected to record your musical typing.

You already know that if you want to record to a single track you simply select the track and record. To record to multiple tracks, you need to arm them with Record Enable buttons.

10 Choose Track > Track Header > Show Record Enable Button.

Record Enable buttons appear on each track. The Record Enable button on the selected track is red to indicate the selected track is targeted for recording. However, since you are recording to two different tracks, and only one track can be selected at a time, you’ll have to arm the tracks. How? Just click the Record Enable button. When it turns red with a white center, it is armed to record even if the track isn’t selected. The Audio 1 Record Enable button will flash, while the Software Instrument track’s button remains solid red. Clicking the Record Enable buttons again will turn them off.

11 Click the Record Enable button on the audio track you just created, and the track you want to use for recording musical typing so that both are armed (red).
It’s also a good idea to monitor the input of your audio track so you can hear your microphone through headphones along with the musical typing.

**NOTE** If you do not see the Input Monitoring button, Control-click (or right-click) the Audio 1 track header and choose Track Header Components > Show input Monitoring from the shortcut menu.

12 Click the Record button in the transport controls and play a few notes on the Musical Typing keyboard. At the same time, speak, sing, or whistle toward the built-in microphone.

Experiment with the different sounds. If you have a MIDI keyboard attached that is also an audio interface, you may be able to record more tracks simultaneously. In Lesson 5, “Recording and Editing Audio Tracks,” you’ll explore recording vocal tracks. In Lesson 6, “Working with Electric Guitars,” you’ll explore guitar recording.
Lesson Review

1. What button determines if the playhead stays in the visible area of the window or continues off the right edge of the window?
2. What window allows you to use your computer’s keyboard as a MIDI instrument?
3. Where is the control that lets you make multiple-take recordings of a Software Instrument rather than a merged recording?
4. Is Cycle mode required for single-take recording?
5. How do you choose between takes in multiple-take recording?
6. If you quantize a region in the Piano Roll Editor, what will happen?
7. What happens if you Option-drag an arrangement marker?
8. Which controls need to be turned on in the track header to record to multiple tracks?

Answers

1. The Catch button, if turned on, keeps the playhead in the visible area of the window. When it is turned on, the window is in Catch mode.
2. The Musical Typing window allows you to use your computer’s keyboard as a MIDI instrument.
3. In GarageBand General Preferences, you will find a control that you deselect for multiple takes or select for merged Software Instrument recordings.
4. Cycle mode must be turned off to record a single take.
5. You can click the Takes menu in the upper-left corner of a multiple-take region to change takes.
6. Quantizing a region in the Piano Roll Editor will fix the timing of all the MIDI note events according to the specified value, such as 1/16 or 1/4 notes, which correspond to lines in the Piano Roll Editor grid.
7. If you Option-drag an arrangement marker, all the regions within that marker will be copied, along with the marker, and moved to wherever you drag the marker. This technique is useful for duplicating parts of the song such as the verse and chorus.
8. The Record Enable buttons need to be turned on in each track that you want to arm for recording.
Index

A

acoustic guitar
changing Software Instrument tracks, 43–44
copying and moving parts of a song, 144
creating new track, 44–46
duplicating regions, 50–51
duplicating tracks, 55–56
example of Software Instrument tracks, 40–41
moving regions to different tracks, 49–50
playing with onscreen music keyboard, 48
Add Track button
creating new track, 44–46
drummer tracks, 57–59, 241
multiple tracks, 147–148
Add Track button
creating new track, 44–46
drummer tracks, 57–59, 241
multiple tracks, 147–148
AIFF files, 298
Ambience Send control, screen controls, 166
Amp Collection, 191, 231–232
Amp Designer
Apple Loops, drummer tracks
changing amp models, 213–216
interface, 209–210
minimizing interface, 212
opening, 19
parameter areas, 210–211
playback and, 211
viewing/selecting amp models, 211–212
amps
changing amp models, 213–216
custom amps, 216–222
default effects, 195–196
designing, 209–216
parameters, 213
Smart Controls pane and, 19
stompboxes (pedals) and, 198–204
viewing/selecting amp models, 211–212
Analyzer, 288–292
Apple applications, sharing projects with, 296
Apple Loops
adding and auditioning (tambourine example), 27–31
adding regions to Loop Library, 264–267
adjusting track volume, 87–88
arranging in timeline, 94
building rhythm tracks, 94–99
building songs, 107–108
customizing keyword buttons, 89–92
deleting tracks, 85
extending with Loop tool, 30–31
making recorded audio regions loop ready, 257–259
making recorded MIDI regions loop ready, 254–256
melody and rhythm and, 93–94
overview of, 26–27, 73
preferences, 77–79
review, 108–109
ringtone template and, 75–77
searching for, 79–84
searching for using keywords, 86–87
searching for using multiple keywords, 92–93
selecting favorites, 100–104
template for loop-based project, 74–75
tempo track and, 268
arpeggiator
Fingerstyle Bass Arpeggiator, 40–41, 127–130
recording arpeggiated drum machine beats, 251–253
selecting favorite loops, 103
arrangement markers
copying parts of a song, 140–145
creating, 141
arrangement tracks
copying parts of a song, 140–145
creating, 53–55
selecting/deselecting, 54
arranging songs
exercises, 105, 107
in timeline, 94
Audio Editor
Catch button, 113
overview of, 21
Real Instrument region of, 22
removing parts of a region, 169–174
Software Instrument region of, 23–24
viewing RSD Stomp Claps track, 257–259
working with flex markers, 260–262
Audio Input pop-up menu, 158
Audio/MIDI preferences, built-in microphones, 148
Audio MIDI Setup utility, 146
audio regions. See regions
audio tracks
adjusting project settings, 158–159, 162–164
default project setting, 154–158
default ringtone settings, 75
deleting unused takes from multtake region, 183–185
doubling, 287
editing multtake audio region, 175–178
example of audiobook narration session, 164–169
microphone in creating, 148–149
mono vs. stereo recording, 161–162
options in New Track dialog, 45
overview of, 153
preparing to record, 154
removing parts of a region, 169–174
review, 186–187
splitting regions in timeline, 178–182
types of tracks, 160–161
viewing number of, 39
vocal recording and editing exercises, 185–186
audio waveforms. See waveforms
audiobook narration session, 164–169
auditioning
drummer presets, 62–63
loops, 27–31
tracks, 147
Auto Normalize feature, 298
automation (A) curves, for volume and panning, 280–283
Autoplay, iOS Smart Guitar example, 41
B
B shortcut key. See Smart Controls (B)
bass, EQ effect presets, 276
Index 309

bass guitar. See also Fingerstyle Bass
creating bass part with arpeggiator, 127–130
exercise arranging songs, 105
rhythm of song and, 93–94
waveforms for, 244

beats
arranging songs, 107–108
building rhythm tracks, 99–100
quantizing notes, 134
recording arpeggiated drum beats, 251–253
recording multipass drum beats, 246–247
sorting piano loops by, 80, 83
tempo track and, 268
viewing beats per measure, 122–123
Beats button, 89–90, 92
Blue Snowball USB microphone, 155
Blueprint Beat button, 92
Blueprint Beat track, 96–98
breath sounds, editing, 171, 173
Bright Vocal patches, 17
Button view, 104

C

Cabinet pop-up, amps and, 217
Catch mode, for keeping playback visible, 112–114
Category pop-up menu, stompbox effects, 201–202
CDs, burning songs to, 296, 298
channels, for audio recording, 162
chorus track
changing name of, 142
copying and moving arrangement marker for, 142–143
musical parts of a song, 53–54
clapping, 257–259
Classic Electric Piano, 46–48
Classic Vocal patch, 15, 17–18
clean sound, 195
clipping, checking output level for, 296
color indicators
blue color for selected note, 123
green color for finished takes, 132, 250
green color for safe volume levels, 280
orange color for Reset button, 89
purple color for metronome, 84
red color for dangerous volume level, 280
red color for recording, 119, 250
yellow color for caution relative to volume level, 280
Column view, selecting favorite loops, 100, 104
Command-A (select all), 135
Command-D (duplicate), 55–56, 115
Command-K (Musical Typing), 116, 147
Command-O (Open dialog), 39
Command-Option-P (Note Pad), 24, 176
Command-Right Arrow, zooming in/out of timeline, 133
Command-S (save), 120
Command-T (splitting timeline regions), 178–182
Compare button, exploring Smart Controls pane, 19
Compressed files, 298
Compressed Vocal patch adding to track, 168
deleting unused takes from multitrack region, 184–185
editing multitrack region, 176–178
viewing in Audio Editor, 170
in vocal recording and editing exercises, 185
compressor adding to master tracks, 278–279
deliberating unused takes from digital recorders, 51–52
screen controls, 166
stompbox effects, 201
customizing keyword buttons, 91
computer keyboard, playing Software Instruments, 116–118
customizer output, volume of, 279
condenser microphones, 218
capture bars, exploring window interface, 6
transport controls, 8
capture points, tempo, 268–270
copying/pasting
electric guitar regions, 227–228
parts of a song, 140–145
Count-in button, on metronome, 119
cowbells adding regions to Loop Library, 264–267
adjusting drum kit instruments, 252
customizing keyword buttons, 91
evaluating rough mixes, 275
making regions loop-ready, 255–256
multipass recording and, 247
working with volume and pan automation curves, 280–283
cycle areas (Cycle mode)
creating, 115
default ringtone settings, 76
for multiple take recording, 130–132, 236
overdubbing and, 248
setting for electric guitar take, 194
turning off when recording single takes, 118
turning on/off, 9–10, 26
working with, 17–18
cymbals, adjusting drum kit instruments, 252

dictation, 165
digital recorders, 51–52
disks, exporting songs to, 296, 304
Display Mode pop-up, 163–164
distortion
stompbox effects, 201
volume level and, 280
doubled audio tracks
creating, 287
guitars and, 222–223
working with Graphic EQ, 288–292
drum kit controls, 61, 64–66
Drummer Editor (E)
auditioning preset, 62–63
creating drummer tracks, 58, 241
exploring, 61
Follow Rhythm option, 245
opening, 194
overview of, 21
viewing drummer information, 59
viewing virtual drummers, 244
drummer tracks.
See also percussion tracks
adding to electric guitar take, 193–195
auditioning preset, 62–63
controlling timing, 240–243
copying and moving arrangement markers, 144
creating, 57–59, 239
drum kit controls, 64–66
Drummer Editor and, 61
dubbing preferences, 248
following rhythm of another track, 244–246
making recorded audio regions loop ready, 257–259
making recorded MIDI regions loop ready, 254–256
New Track dialog, 45
recording arpeggiated drum beats, 251–253
recording multipass drum beats, 246–247
reordering, 59–60
rhythm of song and, 93–94
waveforms of, 245
dubbing preferences, percussion, 248
duplicating tracks, 55–56
dynamic microphones, 218
dubbing preferences, percussion, 248
duplicating tracks, 55–56
dynamic microphones, 218
E shortcut key.
See Piano Roll Editor (E)
echo effect, electric guitars, 197
Echo Send control, in Smart Control pane, 20
Edit menu
cut, copy, paste, 50
Join Regions option, 262–264
Undo Length Change option, 183–185
editing/editors
audio tracks. See Audio Editor
equation of multiple musical notes simultaneously, 136–139
editing vocal recording, 185–186
exploring editors, 21–24
hiding editors, 26
switching between editors, 134
types of editors, 21
effects. See also patches
adding to master track, 278–279
adding to vocals, 167
creating electric guitar effects by moving regions to different tracks, 206–209
defaults for electric guitar, 195–198
EQ presets, 276–278
parameters, 210
resetting, 204–205
for stompboxes (pedals), 198–204
for eight-track recorders, 51–52
electric guitar
Amp Designer and, 209–216
connecting guitar and preparing for recording session, 192
copying/pasting regions in timeline, 227–228
creating patches by moving regions to different tracks, 206–209
custom amps, 216–222
default effects, 195–198
doubling tracks, 222–223
overview of, 189–190
recording own tracks, 231–236
recording sessions, 190–191, 193–195
recording tracks without a guitar, 229–231
resetting effects, 204–205
review, 237
splitting regions to create dynamic change, 223–226
using stompboxes (pedals), 198–204
working with multiple take regions, 227
electric guitar tracks
copying/pasting regions in timeline, 227–228
doubling, 222–223
recording own, 231–236
recording without a guitar, 229–231
splitting regions to create dynamic change, 223–226
working with multiple take regions, 227
Electronic button
customizing keyword buttons, 90
searching for loops using multiple keywords, 92
end-of-project marker, default settings for ringtone template, 76
EQ (equalizer)
adding to master track, 278–279
amp presets, 215–216
custom amps and, 218
effect presets, 276–278
overview of, 19
working with Graphic EQ, 288–292
exporting
project as movie, 302–303
ringtone to iTunes, 300–301
songs to disk, 304
songs to iTunes, 298–300
songs to SoundCloud account, 301–302
F
fading out, master track, 303
favorites, loops, 100–104
feedback, avoiding when recording, 150
guitar
acoustic. See acoustic guitar
building rhythm tracks in timeline, 99–100
comparing melody and rhythm, 93–94
electric. See electric guitar
EQ effect presets, 276–278
mono vs. stereo recording, 162
panning tracks, 276
waveforms, 244
H
hard disks, exporting songs to, 296, 304
headphones
evaluating rough mixes, 274
input monitoring and, 149–150, 162
monitoring electric guitar, 192
Hi-Hat control, in drum kit, 64–65
horizontal zoom slider
expanding audio waveform with, 22
understanding Tracks area, 8
zooming in/out of timeline, 51–52

I
iCloud, opening/saving projects via, 304–306
icons, changing track name and, 32–34
Input Device pop-up menu, 148
Input Monitoring button, on track header, 162, 192
input options
adjusting audio track settings, 160
choosing input source, 158
for electric guitar, 235
for microphone, 148
preparing to record audio tracks, 154
Input pop-up menu, 161, 235
inspector (i), Smart Controls
exploring Smart Controls pane, 18–19
monitoring and, 233–234
working with Reverb Send control, 19–21
instruments. See also by specific types
mono vs. stereo recording, 161–162
Real Instruments, 22, 37
searching for loops using keywords, 86–87
Software Instruments. See Software Instruments
interfaces
Amp Designer interface,
209–210, 212
GarageBand window interface, 5–8
stompbox interface, 199–200
intro tracks
copying and moving arrangement marker for, 143
musical parts of a song, 53–54
iOS
GarageBand for, 39
iOS Smart Guitar, 41
iPhone, creating audio track for, 39
iTunes
exporting ringtone to, 296, 300–301
exporting songs to, 296, 298–300
preferences, 297–298

J
Join Regions option, Edit menu, 262–264

K
K shortcut key. See metronome (K)
key
default settings, 157
defined, 156
loop preferences and, 79
project properties, 154–155
viewing in LCD display, 163
Key Signature pop-up menu, 157
Key Signature pop-up menu, 157
Keyboard Collection template, 146
keyboards
comparing melody and rhythm, 93–94
computer keyboard, 116–118
creating audio tracks, 39
MIDI keyboard. See MIDI keyboard
onscreen music keyboard, 46–48
playback options, 116
prebuilt keyboard tracks, 147
USB keyboard, 13
keywords
customizing keyword buttons, 89–92
loops preferences, 78
searching for loops using, 86–87
searching for loops using multiple, 92–93
kick
drum presets, 245
hearing kick drum, 249
Kick & Snare control, in drum kit, 64

L
LCD display
changing based on playhead position, 10
exploring window interface, 6
viewing project tempo, key, and time signature, 163
LED power indicator, on stompbox, 207
Library (Y)
changing Software Instrument tracks, 44
exploring, 14–17
hiding, 26, 59, 176
"Life's Flower," 164
Locate Files dialog, 284
loop browser
adjusting volume levels, 87–88
button options, 89
default ringtone settings, 76
loops preferences, 78–79
showing/hiding, 30
Loop Library, adding regions to, 254, 264–267
Loop tool, extending loops with, 30–31
loops. See Apple Loops
lyrics, 93
M
M shortcut key. See mute controls (M)
Mac computers
connecting electric guitar to MacBook Pro, 192
connecting instruments to, 235
sharing files, 304–305
maracas
adding percussion to lead melody, 88
building rhythm tracks, 95–96
searching for loops using keywords, 86
Marquee tool, Audio Editor, 171–172
master output volume, 279–280, 298
master parameter, amps, 213
master tracks
adding effects patch and EQ, 278–279
exploring Smart Controls pane, 19
fading out, 303
volume of, 279
Media Browser
accessing Apple applications with, 299–300
sharing projects and, 296
melody
comparing with rhythm, 93–94
Twilight Piano and, 95
menu bars, in tracks area, 8
metronome (K)
default ringtone settings, 76–77
multiple-take recording and, 131–132
setting "count-in" before recording, 119
setting for electric guitar take, 193–194
Tap Tempo button and, 163
turning on/off, 84, 117, 125
Mic pop-up, 217–218
microphones
adjusting track settings, 160
built-in, 158
creating audio tracks, 148
parameters, 211
positioning, 168
preparing to record audio tracks, 154–155
Recording Level slider, 235
recording voice track with, 146
viewing available, 217–218
MIDI keyboard
recording multiple tracks and, 146
recording rough draft, 248–250
MIDI regions
identifying in workspace, 13–14
making regions loop-ready, 254–256
recording, 13
Mix controls, adjusting drum kit instruments, 251–252
mixers/mixing
adding effects and EQ to master track, 278–279
adding to vocals in mixing process, 167
adjusting volume levels, 88
connecting to movie file, 283–284
EQ effect presets, 276–278
evaluating master output level, 279–280
evaluating rough mixes, 274–275
evaluating sound of movie file, 284–287
exercises, 292
fading out master track, 303
mono vs. stereo recording and, 161–162
overview of, 273–274
panning tracks, 275–276
review, 293
track mixer, 7
working with Analyzer and Graphic EQ, 288–292
working with volume and pan automation curves, 280–283
Model parameters, Amp Designer, 210
Model pop-up
customizing amps, 216–217
viewing/selecting amp models, 211–212
monitoring
adjusting audio track settings, 161
audio input, 149–150
Input Monitoring button, 162
preparing to record audio tracks, 154
turning on/off, 233–234
mono
changing to stereo, 234
vs. stereo recording, 161–162
mood
customizing keyword buttons, 90
searching for loops using keywords, 86–87
selecting favorites and, 101
movies
connecting to movie file, 283–284
creating, 66–70
evaluating sound of, 284–287
exporting project as, 302–303
multi-track recording, of Software Instruments, 146–150
multipass recording, of drum beats, 246–247
multiple-take recording
deleting unused takes from multitake region, 183–185
editing multitake audio region, 175–178
selecting take among multiple takes, 132–136
of Software Instruments, 130–132
splitting regions in timeline, 178–182
tempo for, 235–236
working with multiple take regions in recording electric guitar, 227
music parts, identifying in workspace, 11–12
Musical Digital Interface. See MIDI keyboard
Musical Typing
playing cowbells, 247
playing Software Instruments, 116–118
recording Fingerstyle Bass track, 41
recording MIDI regions, 13
recording multiple tracks, 146–150
recording rough draft, 248–250
mute controls (M)
muting Slow Motion and Blueprint tracks, 95
working with tracks, 42
names, changing track name, 32–34
narration
editing, 169–174
vocals as audio instrument, 153
Natural Vocal patch
adding to track, 167–168
frequency curve of, 289
New Project button, 74
New Track dialog
creating audio tracks, 148
creating drummer tracks, 57–59, 241
options, 45
Note Pad
displaying, 176
hiding, 26, 170
options for adding text, 165
overview of, 24–25
notes, musical
editing multiple notes simultaneously, 136–139
fixing with Piano Roll Editor, 121–123
ordering in arpeggiator, 128
quantizing in regions, 124–126
octave
lowering range of, 249
range setting in arpeggiator, 128
onscreen music keyboard
adjustment options, 47
playing notes, 48
playing tracks, 46–47
Open dialog (Command-O), 39
opening projects, 3–5, 38
Option-drag, for duplicating regions, 50–51
orange color, Reset button and, 89
overdubbing
arpeggiated drum beats, 251–253
recording rough draft, 248–250
Software Instruments, 248
panning
adjusting Pan overlay, 222–223
controls in track header, 42
evaluating rough mixes, 274–275
panning guitar tracks, 275–276
working with automation curves, 280–283
parameter areas, Amp Designer, 210–211
parameters
amp, 213
effect, 210
microphone, 211
patches. See also effects
adding to master track, 278–279
adding to tracks, 167–168
creating electric guitar effects by moving regions to different tracks, 206–209
legacy, 16–17
managing from library, 15
resetting effects, 204
selecting for electric guitar take, 196
viewing list of, 166
Pedalboard plug-in. See also stompboxes (pedals)
categories of pedals, 201–202
closing pedals, 204
default effects, 196
interface and options, 199–200
playback of pedals, 203–204
removing some pedals, 201
resizing interface, 203
Router for pedal control, 200–201
selecting pedals, 202

perceção
building rhythm, 95–96
comparing melody and rhythm, 93–94
non-instrumental, 285
searching for instruments using keywords, 86–87

Percussion slider, drum kit controls, 65–66
percussion tracks. See also drummer tracks
adding regions to Loop Library, 264–267
building rhythm tracks, 95–96
controlling timing using Groove tracks, 240–243
following rhythm of another track, 244–246
making recorded audio regions loop ready, 257–259
making recorded MIDI regions loop ready, 254–256
merging audio regions, 262–264
overdubbing preferences, 248
overview of, 239
recording arpeggiated drum beats, 251–253
recording multipass drum beats, 246–247
recording rough draft, 248–250
review, 271
working with flex markers in Audio Editor, 260–262
working with tempo track, 267–270
performance controls, drummer options, 61
piano. See also keyboards
changing Software Instrument tracks, 43–44
exercise arranging songs, 105, 107–108
searching for loops by keyword, 80
selecting favorite loops, 102
sorting loops by beat, 83
Twilight Piano, 81–82, 95
working with tempo track, 268

Piano Roll Editor (E)
Catch button, 113
editing multiple musical notes simultaneously, 136–139
fixing notes, 121–123, 134–136
quantizing notes in a region, 124–125, 256
types of editors, 21
viewing Software Instrument regions, 23–24
 pitch, using library to change, 15
playback
Amp Designer and, 211
auditioning and adding loops to projects, 29–31
keyboard options, 116
positioning playback in ruler, 9–11
stompboxes (pedals), 203–204
transport controls for, 8–9
playhead
Catch mode for keeping visible, 112–114
moving with Audio Editor, 170
positioning, 9–11
splitting regions in timeline, 178–182
understanding Tracks area, 7–8
preferences
Cycle Recording, 130–131
iTunes, 297–298
loop, 77–79
overdubbing, 248
presence, amp parameters, 213
presents
amp, 215–216
drummer, 61, 62–63
EQ effects, 276–278
Project Chooser, 74, 155
projects, working with
adjusting track volume, 31–32
auditioning and adding loops to projects, 29–31
changing track name and icon, 32–34
downloading lesson files, 2–3
exploring editors, 21–24
exploring library, 14–17
exploring Smart Controls pane, 18–21
exploring window interface, 5–6
identifying music parts in workspace, 11–12
identifying regions and tracks in workspace, 13–14
opening/saving, 3–5
overview of, 1
positioning playback in ruler, 9–11
review, 34–35
Tracks area of interface, 6–8
transport controls, 8–9
using cycle areas, 17–18
viewing project note pad, 24–25
working with Apple Loops, 26–29
properties, audio tracks
adjusting project settings, 158–159, 162–164
default settings for project, 154–158
purple color, for metronome when on, 84
Q
Quality pop-up menu, 299
Quantize button, 124–126
Quantize pop-up menu, 256
quantizing notes
with Piano Roll Editor, 134–136
in regions, 124–126, 256
R
Ready Set Dance, 285
Real Instruments
region of Audio Editor, 22
track capacity and, 37
Record Enable button
preparing to record electric guitar, 192
recording on multiple tracks, 235
on tracks, 149
recording
audio. See audio tracks
drums. See drummer tracks
keyboard options and, 116
MIDI regions, 13
mono vs. stereo, 161–162
multiple-take. See multiple-take recording
multiple tracks of Software Instruments, 146–150
rough draft of MIDI keyboard, 248–250
single-takes. See single-take recording
using Piano Roll Editor to fix notes, 121–123
waveform of horn recording, 16
recording, electric guitar
connecting guitar and preparing for, 192
elements of, 191
making the recording, 193–195
opening project, 190–191
Recording Level slider, microphone, 235
red color
danger indicator for volume level, 280
indicating recording, 119, 250
regions
adding to Loop Library, 264–267
copying/pasting in timeline, 227–228
creating effects by moving to different tracks, 206–209
deleting unused takes from multitake region, 183–185
duplicating, 50–51
editing audio region, 175–178
identifying in workspace, 13–14
making audio regions loop ready, 257–259
making MIDI regions loop ready, 254–256
merging audio regions, 262–264
moving to different tracks, 49–50
multiple-take recording and, 227
quantizing notes in, 124–126
removing parts of a, 169–174
resizing, 52–53
selecting/deselecting, 12
showing in editors, 22
single-take recording and, 114
splitting in timeline, 178–182
splitting to create dynamic change, 223–226
Tracks area and, 7
Reset button, 89, 91
Resize/Trim tool, 52–53
reverb
adding effects to vocals, 167
creating effects by moving regions to different tracks, 207
custom amps and, 218
default effects for electric guitar, 197
screen controls, 215
Reverb Send control, 19–21, 166
rhythm
arranging songs and, 105–106
building rhythm tracks, 94–99
comparing with melody, 93–94
following rhythm of another track, 244–246
Ribbon 121 microphone, 218
ringtones
exporting to iTunes, 296, 300–301
opening template for loop-based project, 74–75
searching for loop for, 79–84
searching for loops by keywords, 86–87
template for, 75–77
room tone, 174
Router, for pedal control, 200–201
RSD Stomp Claps track
Flex-Time analysis and, 257–259
merging audio regions, 262–264
overview of, 254
ruler
dragging cycle area of, 26
positioning playhead in, 9–11
Tracks area and, 7
turning on Cycle mode, 9–10
S
S shortcut key. See solo controls (S)
Sacco, Tina, 164, 185
saving projects, 3–5
Score Editor
hiding, 26
overview of, 21
showing selected track in, 115
switching between editors, 134
viewing name or key of notes, 116
viewing Software Instrument regions, 23–24
score, scoring video using thumbnails, 69
screen controls
compressor switch, 166
disabling (dimmed), 215
for electric guitar, 197–198, 200–201
exploring Smart Controls pane, 18
gain and reverb, 215
viewing effects, 207
searching for loops
overview of, 79–84
using keywords, 86–87
using multiple keywords, 92–93
selection/deselection
arrangement tracks, 54
Audio Editor tool for, 171
notes, 135
regions, 12
showing selected track in Score Editor, 115
takes, 133
tracks, 20–21
Settings pop-up menu, 219–220
sharing projects
exporting project as movie, 302–303
exporting ringtone to iTunes, 300–301
exporting songs to disk, 304
exporting songs to iTunes, 298–300
exporting songs to SoundCloud account, 301–302
fading out the master track, 303
opening/saving projects via iCloud, 304–306
with other Apple applications, 296
overview of, 295
review, 307
setting iTunes preferences, 297–298
single-take recording
drum part, 246–247
editing single-take audio region, 169–174
preparing to record electric guitar, 192
recording single take in timeline, 118–121
of Software Instruments, 114–116
slow motion
arranging songs, 105
building rhythm tracks in timeline, 97
searching for loops by keyword, 82–83
Smart Controls (B)
accessing in Pedalboard option, 198–199
default effects for electric guitar, 197–198
EQ controls, 276–278
exploring, 18–19
hiding, 21
prebuilt keyboard tracks, 147
preparing to record electric guitar, 192
recording arpeggiated drum machine beats, 251–253
viewing impact of changing patches, 168
viewing list of patches, 166
working with arpeggiator, 127–130
working with Reverb Send control, 19–20
snare
drum presets, 245
playback, 249
SoCal drummer
creating tracks, 58–59
reordering tracks, 59–60
Software Instruments
Catch mode for keeping playhead visible, 112–114
changing tracks, 43–44
copying parts of a song using arrangement track, 140–145
editing multiple musical notes simultaneously, 136–139
fixing notes with Piano Roll Editor, 121–123
hearing assigned instrument, 46–48
multiple-take recording, 130–132
multiple track recording, 146–150
options in New Track dialog, 45
overdubbing, 248
Index 315

overview of, 111
playing with computer keyboard, 116–118
quantizing notes in a region, 124–126
region of Audio Editor, 23
review, 151
selecting take among multiple takes, 132–136
single-take recording, 114–116
single-take recording in timeline, 118–121
tempo and key changes and, 155
track capacity and, 37
working with Smart Controls and the arpeggiator, 127–130
solo controls (S)
selecting takes and, 133
working with tracks, 42
Sound Effect button, 89–90
sound, evaluating movie files, 284–287
SoundCloud
exporting songs to, 301–302
sharing projects and, 296
spacebar, playing/stopping songs, 8–9
speakers
evaluating rough mixes, 274
input monitoring and, 162
stereo
adjusting. See panning
changing Mono to, 234
evaluating rough mixes, 274–275
vs. mono recordings, 161–162
Stiltz, Colby, 267
stompboxes (pedals). See also Pedalboard plug-in
accessing, 198–199
categories of, 201–202
closing, 204
controlling with Router, 200–201
default effects, 196
exploring Smart Controls pane, 19
interface and options, 199–200
playback, 203–204
removing, 201
resizing interface for, 203
selecting, 202
Strength slider, Time Quantize feature, 125
String Ensemble track
duplicating regions, 50–51
editing multiple musical notes simultaneously, 136–139
moving regions to different tracks, 49–50
preparing to record electric guitar, 192
recording single take in, 118–121
splitting regions in, 178–182
starting playback from specific position in, 9–11
Tracks area and, 7
zooming in/out, 51–52, 133
timing
controlling using Groove tracks, 240–243
fixing notes with Piano Roll Editor, 121–123
making regions loop-ready, 254–256
quantizing notes in a region, 124–126
take headers
basic controls, 42
deleting tracks using shortcut menu, 125
Input Monitoring button on, 162
Show Groove Track option, 242
Tracks area and, 7
viewing, 11–12
track mixer, 7
trackpad, 39
track tracks
arrangement tracks. See arrangement tracks
audio tracks. See audio tracks building rhythm tracks, 94–99
changing icon, 32–34
changing name, 32–34, 142
changing Software Instrument tracks, 43–44
creating, 44–46
creating movie tracks, 66–70
deleting, 85, 125
drum. See drummer tracks
duplicating, 55–56
duplicating regions, 50–51
electric guitar. See electric guitar tracks
exploring project tracks, 40–41
identifying in workspace, 13–14
master tracks. See master tracks
moving regions to different tracks, 49–50
onscreen music keyboard for playing, 46–48
opening project from GarageBand, 38
overview of, 37–38
panning, 275–276
percussion. See percussion tracks previewing finished project and, 38–39
recording multiple, 146–150
reordering, 59–60
resizing regions, 52–53
review, 70–71
selecting, 20–21
showing selected track in Score Editor, 115
solo and mute controls and, 42
Tracks area and, 6–8
volume adjustments, 31–32, 87–88, 279
zooming in/out of timeline, 51–52

Tracks area
exploring window interface, 6
overview of, 6–8
resizing regions, 52–53
transport controls
for playback, 8–9
for playback of loops, 29–31
treble, EQ effect presets, 276
tremolo effect, 207, 215
Trim tool, Audio Editor, 171
Tuner/tuning
  closing Tuner, 236
tuning electric guitars, 193, 231, 235–236
Twilight Piano, 81–82, 95

V
verse
changing name of verse track, 142
copying and moving arrangement marker for verse track, 142–144
musical parts of a song, 53–54
vibrato effect, 215
vocals
  adding Compressed Vocal patch to track, 168
  adding effects in mixing process, 167
  adding Natural Vocal patch to track, 167–168
  as audio instrument, 153
deleting unused takes from multitake region, 184–185
editing multitake region, 176–178
frequency curve of Natural Vocal patch, 289
melody line of song and, 93
patches, 16–18
recording and editing exercises, 185–186
viewing Compressed Vocal patch in Audio Editor, 170
in vocal recording and editing exercises, 185
voice track, recording, 146
volume
  adjusting track volume, 31–32, 87–88
  Amp Output slider, 211
controls in track header, 42
dynamic change, 223–226
  evaluating rough mixes, 274–275
fading out master track, 303
lowering decibel levels, 51
master output level, 279–280
working with volume automation curves, 280–283

W
Waronicki, Chad, 190–193
waveforms
  for drummer track, 245
  editing and, 171
  flex markers and, 260–262
  for guitar and bass tracks, 244
  for horn recording, 16
  overview of, 13
  viewing with Audio Editor, 21–22
windows interface
  identifying music parts, 11–12
  identifying tracks and regions, 13–14

X
XY pad, drummer options, 61

Y
Y shortcut key. See Library (Y)
yellow color, caution indicator for volume level, 280

Z
zooming in/out
  of timeline, 51–52, 133
Tracks area and, 8